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Notices

REACH

Complying with the REACH (Registration, Evaluation, Authorisation, and Restriction of
Chemicals) regulatory framework, we published the chemical substances in our products at
ASUS REACH website at http://green.asus.com/english/REACH.htm

Federal Communications Commission Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions:
+  This device may not cause harmful interference; and

+  This device must accept any interference received including interference that may cause
undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with manufacturer’s instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur
in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following measures:
+  Reorient or relocate the receiving antenna.

+ Increase the separation between the equipment and receiver.

+  Connect the equipment to an outlet on a circuit different from that to which the receiver is
connected.

+  Consult the dealer or an experienced radio/TV technician for help.

k The use of shielded cables for connection of the monitor to the graphics card is required
to assure compliance with FCC regulations. Changes or modifications to this unit not
expressly approved by the party responsible for compliance could void the user’s authority
to operate this equipment.
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RF exposure warning

This equipment must be installed and operated in accordance with provided instructions and
the antenna(s) used for this transmitter must be installed to provide a separation distance of
at least 20 cm from all persons and must not be co-located or operating in conjunction with
any other antenna or transmitter. End-users and installers must be provide with antenna
installation instructions and transmitter operating conditions for satisfying RF exposure
compliance.

Canadian Department of Communications Statement

This digital apparatus does not exceed the Class B limits for radio noise emissions from
digital apparatus set out in the Radio Interference Regulations of the Canadian Department of
Communications.

This class B digital apparatus complies with Canadian ICES-003.

Macrovision Corporation Product Notice

This product incorporates copyright protection technology that is protected by method

claims of certain U.S. patents and other intellectual property rights owned by Macrovision
Corporation and other rights owners. Use of this copyright protection technology must be
authorized by Macrovision Corporation, and is intended for home and other limited viewing
uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering
or disassembly is prohibited.

Lithium-lon Battery Warning

CAUTION: Danger of explosion if battery is incorrectly replaced. Replace only with the
same or equivalent type recommended by the manufacturer. Dispose of used batteries
according to the manufacturer’s instructions.




Safety information

Disconnect the AC power and peripherals before cleaning. Wipe the Desktop PC using a
clean cellulose sponge or chamois cloth dampened with solution of nonabrasive detergent
and a few drops of warm water then remove any extra moisture with a dry cloth.

+ DO NOT place on uneven or unstable work surfaces. Seek servicing if the casing has
been damaged.

+ DO NOT expose to dirty or dusty environments. DO NOT operate during a gas leak.

+ DO NOT place or drop objects on top and do not shove any foreign objects into the
Desktop PC.

+ DO NOT expose to strong magnetic or electrical fields.

+ DO NOT expose to or use near liquids, rain, or moisture. DO NOT use the modem during
electrical storms.

+  Battery safety warning: DO NOT throw the battery in fire. DO NOT short circuit the
contacts. DO NOT disassemble the battery.

+ Use this product in environments with ambient temperatures between 0°C (32°F)and
35°C (95°F).

+ DO NOT cover the vents on the Desktop PC to prevent the system from getting
overheated.

+ DO NOT use damaged power cords, accessories, or other peripherals.

- To prevent electrical shock hazard, disconnect the power cable from the electrical outlet
before relocating the system.

+  Seek professional assistance before using an adapter or extension cord. These devices
could interrupt the grounding circuit.

- Ensure that your power supply is set to the correct voltage in your area. If you are not
sure about the voltage of the electrical outlet you are using, contact your local power
company.

+  Ifthe power supply is broken, do not try to fix it by yourself. Contact a qualified service
technician or your retailer.

vii
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Conventions used in this guide

To ensure that you perform certain tasks properly, take note of the following symbols used
throughout this manual.

9. DANGER/WARNING: Information to prevent injury to yourself
when trying to complete a task.

'\ CAUTION: Information to prevent damage to the components
. when trying to complete a task.

IMPORTANT: Instructions that you MUST follow to complete a
task.

NOTE: Tips and additional information to help you complete a
task.

N 9

Where to find more information

Refer to the following sources for additional information and for product and software
updates.

ASUS websites

The ASUS website provides updated information on ASUS hardware and software
products. Refer to the ASUS website www.asus.com.

ASUS Local Technical Support

Visit ASUS website at http://support.asus.com/contact for the contact information of
local Technical Support Engineer.


http://www.asus.com
http://support.asus.com/contact

Package contents

ASUS Essentio Desktop PC Keyboard x1 Mouse x1

e

Power cord x1 Support DVD x1

Anstehaiion Gude

Nero 9 burning software Installation Guide x1 Warranty card x1
DVD x1

Antenna (optional) x2

% + If any of the above items is damaged or missing, contact your retailer.

- + Theillustrated items above are for reference only. Actual product specifications may vary
with different models.



Getting started

Welcome!

Thank you for purchasing the ASUS Essentio CG5270 Desktop PC!

The ASUS Essentio CG5270 Desktop PC provides cutting-edge performance,
uncompromised reliability, and user-centric utilities. All these values are encapsulated in a
stunningly futuristic and stylish system casing.

R Read the ASUS Warranty Card before setting up your ASUS Desktop PC.

Getting to know your computer

% lllustrations are for reference only. The ports and their locations, and the chassis color vary
- with different models.

Front panel

Click the number to view its
- corresponding description.

ASUS CG5270



1. Power button. Press this button to turn on your computer.

2. Secure Digital™ / MultiMediaCard slot. Insert a Secure Digital™ card or
MultiMediaCard into this slot.

3.  CompactFlash®/ Microdrive™ card slot. Insert a CompactFlash® / Microdrive™ card
into this slot.

4,  Memory Stick™ / Memory Stick Pro™ card slot. Insert a Memory Stick™ / Memory
Stick Pro™ card into this slot.

5.  Memory card reader LED. This LED lights up when a memory card is inserted into
any of the memory card slots and blinks when data is being read from or written to the
memory card.

6.  USB 2.0 ports. These Universal Serial Bus 2.0 (USB 2.0) ports connect to USB 2.0
devices such as a mouse, printer, scanner, camera, PDA, and others.

7.  Headphone port (lime). This port connects to a headphone or speaker.

Microphone port (pink). This port connects to a microphone.

9.  Front l/O ports cover.

10. Optical disk drive bay. There is an optical disk drive in this bay.

11.  Optical disk drive eject button. Press this button to eject the optical disk drive tray.

12. Optical disk drive bay (empty). You may install an additional optical disk drive in this
bay.

13.  Power LED. This LED lights up when you turn on your computer.

Rear panel

e_
Vs
%o
0_
(1 Ol
o
o

Click the number to view its
corresponding description.

N
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Power connector. Plug the power cord to this connector.
Power switch. Switch to turn ON/OFF the power supply to your computer.

Air vents. These vents allow air ventilation.

DO NOT block the air vents on the chassis. Always provide proper ventilation for your
computer.

PS/2 Keyboard / Mouse Combo port (purple). This port is for a PS/2 keyboard or
mouse.

USB 2.0 ports. These Universal Serial Bus 2.0 (USB 2.0) ports connect to USB 2.0
devices such as a mouse, printer, scanner, camera, PDA, and others.

Optical S/PDIF_OUT port. This port connects to an external audio output device via
an optical S/PDIF cable.

HDMI port. This port is for a High-Definition Multimedia Interface (HDMI) connector,
and is HDCP compliant allowing playback of HD DVD, Blu-ray, and other protected
content.

DVI-D port. This port is for any DVI-D compatible device and is HDCP compliant
allowing playback of HD DVD, Blu-ray, and other protected content.

VGA port. This port is for VGA-compatible devices such as a VGA monitor.

USB 2.0 ports. These Universal Serial Bus 2.0 (USB 2.0) ports connect to USB 2.0
devices such as a mouse, printer, scanner, camera, PDA, and others.

LAN (RJ-45) port. This port allows Gigabit connection to a Local Area Network (LAN)
through a network hub.

LAN port LED indications ACT/LINK SPEED
LED LED
Activity/Link LED Speed LED
= )
OFF No link OFF 10Mbps connection -
ORANGE | Linked | ORANGE | 100Mbps connection
BLINKING \ Data activity \ GREEN \ 1Gbps connection LAN port

ASUS CG5270



12.
13.

14.
15.

16.

17.

7

18.

19.

20.

Rear Speaker Out port (black). This port connects to the rear speakers in a 4, 6, and
8-channel audio configuration.

Side Speaker Out port (gray). This port connects to the side speakers in an 8-channel
audio configuration.

Microphone port (pink). This port connects to a microphone.

Line Out port (lime). This port connects to a headphone or speaker. In a 4, 6, or
8-channel configuration, the function of this port becomes Front Speaker Out.

Center/Subwoofer port (orange). This port connects to the center/subwoofer
speakers.

Line In port (light blue). This port connects to a tape, CD, DVD player, or other audio
sources.

Refer to the audio configuration table below for the function of the audio portsin a 2, 4, 6,
or 8-channel configuration.

Audio 2, 4, 6, or 8-channel configuration

Headset

v — 4-channel 6-channel 8-channel
Light Blue Line In Line In Line In Line In
Lime I Line Out I Front Speaker Out I Front Speaker Out I Front Speaker Out
pik | mem | Mic In | Mic In | Mic In
Orange I - I - I Center/Subwoofer I Center/Subwoofer
Black I - I Rear Speaker Out I Rear Speaker Out I Rear Speaker Out
Gray I — I — I — | Side Speaker Out

ASUS WLAN Card (on selected models only). This optional WLAN card allows your
computer to connect to a wireless network.

ASUS Graphics Card (on selected models only). The display output ports on this
optional ASUS Graphics Card may vary with different models.

Expansion slot bracket. Remove the expansion slot bracket when installing an
expansion card.

Chapter 1: Getting started



Setting up your computer

This section guides you through connecting the main hardware devices, such as the external
monitor, keyboard, mouse, and power cord, to your computer.

Connecting an external monitor

Using the ASUS Graphics Card (on selected models only)

Connect your monitor to the display output port on the discrete ASUS Graphics Card.
To connect an external monitor using the ASUS Graphics Card:

1. Connect a monitor to a display output port on the ASUS Graphics Card.

2. Plug the monitor to a power source.

/ The display output ports on the ASUS Graphics Card may vary with different models.

ASUS CG5270




Using the onboard display output ports
Connect your monitor to the onboard display output port.
To connect an external monitor using the onboard display output ports:

1. Connect a VGA monitor to the VGA port, or a DVI-D monitor to the DVI-D port, or an
HDMI monitor to the HDMI port on the rear panel of your computer.

2. Plug the monitor to a power source.

R + If your computer comes with an ASUS Graphics Card, the graphics card is set as the
primary display device in the BIOS. Hence, connect your monitor to a display output port
on the graphics card.

+ To connect multiple external monitors to your computer, refer to Connecting multiple
external monitors in Chapter 3 of this user manual for details.

Chapter 1: Getting started



Connecting a USB keyboard and a USB mouse

Connect a USB keyboard and a USB mouse to the USB ports on the rear panel of your
computer.

Connecting the power cord

Connect one end of the power cord to the power connector on the rear panel of your
computer and the other end to a power source.

ASUS CG5270



Turning your computer ON/OFF

This section describes how to turn on/off your computer after setting up your computer.

Turning your computer ON
To turn your computer ON:

1. Turn your monitor ON.

2. Turn the power switch ON, then press the power button on your computer.

Power button

ON

3. Wait until the operating system loads automatically.

Turning your computer OFF
To turn your computer OFF:

1. Close all running applications.
2. Click on the Windows® desktop.

Click [EMSSEER to shut down the operating system.
Turn the power switch OFF.

Chapter 1: Getting started



Using Windows® 7

Starting for the first time

When you start your computer for the first time, a series of screens appear to guide you in
configuring the basic settings of your Windows® 7 operating system.

To start for the first time:

1. Turn your computer on. Wait for a few minutes until the Set Up Windows screen
appears.

From dropdown list, select your language. Click Next.

From the dropdown lists, select your Country or region, Time and currency, and
Keyboard layout. Click Next.

4. Key in uniques names for the user name and computer name. Click Next.

5. Key in the necessary information to set up your password, then click Next. You may
also click Next to skip this step without entering any information.

% If you want to set up a password for your account later, refer to the section Setting up a
- user account and password in this chapter.

Carefully read the license terms. Tick | accept the license terms and click Next.

7. Select Use recommended settings or Install important updates only to set up the
security settings for your computer. To skip this step, select Ask me later.

8. Review your date and time settings. Click Next. The system loads the new settings and
restarts. You may now start using your computer.

ASUS CG570 2-1
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Using Windows® 7 desktop

% Click the Start icon @ > Help and Support to obtain more information about Windows® 7.

Start
menu

Taskbar

Notification area

Using the Start menu

The Start menu gives you access to programs, utilities, and other useful items on your
computer. It also provides you with more information about Windows 7 through its Help and
Support feature.

Launching items from the Start menu
To launch items from the Start menu:

1. From the Windows® taskbar, click the Start icon @

2. From the Start menu, select the item that you want to launch.

/ You may pin programs that you want constantly displayed on the Start menu. For more
details, refer to the section Pinning programs on the Start menu or taskbar on this
chapter.

Chapter 2: Using Windows® 7



Using the Getting Started item

The Getting Started item on the Start menu f i ,
contains information about some basic tasks such D) o viesie cemer

as personalizing Windows®, adding new users, and 1 eeting s > |
transferring files to help you to familiarize yourself F emtnes
with using Windows® 7.

W yourfiles
Sticky Notes: W Back up your files

8, Ad

é,;" EPU-4 Engine V10025 = Cha"gitm:\;z
To use the Getting Started item: R supping Too
1. From the Windows® taskbar, click the Start MMD
_ ritkey2000
icon &M to launch the Start menu. A v

2. Select Getting Started. The list of available | % s
tasks appears. -

| Shut down | » |

3. Select the task that you want to do.

Using the taskbar
The taskbar allows you to launch and manage programs or items installed on your computer.

Launching a program from the taskbar
To launch a program from the taskbar:

. From the Windows® taskbar, click an icon to launch it. Click the icon again to hide the
program.

a0
N/

% You may pin programs that you want constantly displayed on the taskbar. For more details,
- refer to the section Pinning programs on the Start menu or taskbar on this chapter.

ASUS CG5270 2.3



Pinning items on the jumplists

When you right-click an icon on the taskbar, a
jumplist launches to provide you with quick-access
to the program’s or item’s related links.You may
pin items on the jumplist such as favorite websites,
often-visited folders or drives, or recently played
media files.

To pin items to the jumplist:

1. From the taskbar, right-click an icon.

2. From the jumplist, right-click the item that
you want to pin, then select Pin to this list.

Unpinning items from the jumplist
To unpin items from the jumplist:

1. From the taskbar, right-click an icon.

Frequent

[@[Pin to this lst Jacri
Tasks

@ Resume previous list

[ Play all music

@ Windows Media Player
o Unpin this program from taskbar

2. From the jumplist, right-click the item that you want to remove from the jumplist, then

select Unpin from this list.

Pinning programs on the Start menu or taskbar

To pin programs on the Start menu or taskbar:
1. From the Windows® taskbar, click the Start icon
to launch the Start menu.

2. Right-click the item that you want to pin on the
Start menu or taskbar.

3. Select Pin to Taskbar or Pin to Start menu.

% You may also right-click on the

icon of a running program on
the taskbar, then select Pin this
program to taskbar.

24

@ Internet Explo| Open

A Microsoft OFf Troubleshoot compatibility
% Microsoft Wol
£, Windows Any,
& Windows DV Pin to Start Menu
53 Windows Fax | )
€ Windows Mes
[ Windows Me Restore previous versions
£ Windows Upe
A XPS Viewer
Accessories cut
). asus Copy
|\ Games
J

)

Pinto Taskbar

Scan for Security Threats

Sendto 3

Msintenance|  Delete

Microsoft Off bizEms
"o Microsoft,
= Microsoft|.
(! Microsoft Office OneNote 2007
(@ Microsoft Office PowerPoint 2007
{ Mierosoft Office Word 2007

|| Microsoft Office Tools
). Microsaft Office Live Add-in

q

Propetties

Back

(&) Al Manager1.07.00

= Pin this program to taskbar

Close window
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Unpinning programs from the Start menu
To unpin programs from the Start menu:

1. From the Windows® taskbar, click the Start icon to launch the Start menu.

2. From the Start menu, right-click the program that you want to unpin, then select
Remove from this list.

Unpinning programs from the taskbar
To unpin programs from the taskbar: T— '
1. From the taskbar, right-click the program 4 | [ Microsoft Office Word 2007 |
that you want to remove from the taskbar, o Unpin this program from taskbar
then select Unpin this program from . -
taskbar.

Using the notification area
By default, the notification area shows these three icons:

Action Center notification

E Click this icon to display all the alert messages/notifications and
launch the Windows® Action Center.

Network connection

. This icon displays the connection status and signal strength of the
wired or wireless network connection.

m Volume

Click this icon to adjust the volume.

Displaying an alert notification
To display an alert notification:

. Click the Notification icon m, then click ’r 1 message
the message to open it.

'S' Set up backup

Open Action Center

5:45 PM
9/7/2009

% For more details, refer to the section Using Windows® Action Center in this chapter.

ASUS CG5270



Customizing icons and notifications

You may choose to display or hide the icons and notifications on the taskbar or on the
notification area.

To customize icons and notifications:

1. From the notification area, click on the arrow icon E
Click Customize.
3. From the dropdown list, select the behaviors for the icons or items that you want

customize.
i Al ControlPanel Rems » Notficabon Aves cons 4 || St Contrl Panel 2
@
Select which icons and notifications appear on the taskbar
wpates.
[cows 1€ by e, Bk the ariow 0 1 the R <Hton drea O Ehe Tk,
leons Behaviors.
Do O erreyeeporrorren =
L e ey PO [Shom ican and notications s
RS Show icon and nethcation: -
R e ~
Oy show notfcations. ~
Restore default <en behavidrs
Aoy show il cons and motficaions on the ackbar
o ][ Canee |

Chapter 2: Using Windows® 7



Managing your files and folders

Using Windows® Explorer
Windows® Explorer allows you to view, manage, and organize your files and folders.

Launching Windows® Explorer
To launch Windows Explorer:

1. From the Windows® taskbar, click the Start icon L% to launch the Start menu.

2. Click Computer to launch Windows Explorer.

Breadcrumb bar View icon
% Computer » « | é3 [ Search Computer —— Search bar
Toolbar —Imcar e e e e e e e - o-ef Preview icon
I Favorites 4 Hard Disk Drives (1)
B Desktop _ WINT (C:)

& Downloads >
%] Recent Places 670 GB free of 698 GB

4 Devices with Removable Storage (2)
G Libraries Removable Disk (E)

[ Documents '@' DVD RW Drve (09 ==
j Music = 7 154 GB free of 377 GB

s
Navigation —f— & Ve
pane 8 Compu

& winT ()
o= Removable Disk ()

— View pane

@ Network

oy ICE-Pc Workgroup: WORKGROUP Memory: 800 GB.
L Processor: Intel(R) Core(TM)2 Qua

Exploring files and folders

To explore files and folders:

1. Launch Windows Explorer.

2. From the navigation or view pane, browse for the location of your data.

3. From the breadcrumb bar, click the arrow to display the contents of the drive or folder.

- » Computer » WINT () »| Users| v [ 4o | Search Users £
J ke .
Organize Includeinlibrary Shd | der = 0l @
e Name (1 Public Date modified Type i
B Desktop gl lee 9/25/200910:04 AM  File folder
& Downloads Mattheu 9/25/200910:04 AM  File folder
] Recent Places Public 9/17/2003603PM  File folder

A Libraries
[ Documents

ASUS CG5270
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Customizing the file/folder view =
Extra Large Icons

To customize the file/folder view:
i=| Largelcons

1. Launch Windows Explorer.
s Medium Icons

2. From the navigation pane, select the location of your fies
data. EE = i Small Icons
From the toolbar, click the View icon = . BE List
4, From the View menu, move the slider to select how you e B2 Details
want to view the file/folder. o
== Tiles
jE Content
/ You may also right-click anywhere GUEERE ¢
- on the View pane, click View, and View » Extra large icons
select the view type that you want. Sort by » Large icons
Refresh Medium icons
Paste Small icons
Paste shortcut =
@  Details
Share with 3 Tiles
Mew 3 Content
Properties

Arranging your files

To arrange your files:

1. Launch Windows Explorer.

2. From the Arrange by field, click to display the dropdown list.
3. Select your preferred arrangement type.

| 43 | Search Documents

| » Libraries » Documents »

Sharevith v Bum  Newfolder

e
i Faveries Documents library
B Desktop Includes: 2 locations
 Downloads =
i Recent Places

Book

Movies 1 Filefolder

A Libraries
[ Documents
o Music
& Pictures
i Videos

% Computer
& wing ()

= Removable Disk (E)

€ Network

o 2iems

Chapter 2: Using Windows® 7



Sorting your files

To sort your files: Arntange by ,
. View >
1. Launch Windows Explorer. — el
Right-click anywhere on the View pane. Ll [ TR
Refresh Type
From the menu that appears, select Sort Paste Size
by, then select your preferred sorting type. Paste shortcut ©  Ascending
Undo Copy Ctrl-Z Descending
Share with 3 More...
New 3
Properties
Grouping your files e N
To group your files: View ,
Sort by »
1. Launch Windows Explorer. Group by > @ Name
. . . Refresh Date medified
Right-click anywhere on the View pane. —— T
Si
From the menu that appears, select BT g
Group by, then select your preferred UndoRename - CulZ e
H Sh h
grouping type. e i [
New >
More...
Properties I
Adding a new folder
To add a new folder:
1. Launch Windows Explorer.
. Organize Share with = Burn MNew folder
2. From the toolbar, click New folder. 3
3. Keyin a name for the new folder.
Arrange by
View
% You may also right-click anywhere .
L on the View pane, click New > Refresh
Folder. Paste
Paste shorteut
Undo Rename Ctrl+Z
Share with
New | Folder
RS #] Shortcut
[ Bitmap image
Contact
@] Microsoft Office Word Document
[£ Journal Document
| TextDocument
3y Windows Live Call
] Microsoft Office Excel Worksheet
4y Compressed (zipped) Folder
£ Bricfcase
ASUS CG5270




Backing up your files

Setting up a backup
To set up a backup:

1. Click & > All Programs > Maintenance > Backup and Restore.
2. Click Set up backup. Click Next.

& « System and Security » Backup and Restore v | 3 Wl Search Control Panel )
Control Panel H 8
i e Back up or restore your files
) Create a system image Backup
%) Create a system repair disc Windows Backup has not been set up. & set up backup

Restore
Windows could not find a backup for this computer.

@5elect another backup to restare files fram

Recover system settings o your computer

3. Select your backup destination. Click Next.

4.  Select Let Windows choose (recommended) or Let me choose as your backup
mode.

% If you select Let Windows choose, Windows will not back up your programs, FAT-
- formatted files, Recycle Bin files, or temporary files that are 1GB or more.

5. Follow the onscreen instructions to finish the process.

Restoring your system

The Windows® System Restore feature creates a restore point where the computer’s system
settings are stored at certain time and date. It allows you to restore or undo changes to your
computer’s system settings without affecting your personal data

To restore your system:

1. Close all running applications.

2. Click

3. Follow the onscreen instructions to complete the process.

> All Programs > Accessories > System Tools > System Restore.
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Protecting your computer

Using Windows® 7 Action Center

Windows® 7 Action Center provides you with alert notifications, security information, system
maintenance information, and the option to automatically troubleshoot and fix some common
computer problems.

% You may customize the notifications. For more details, refer to the previous section
Customizing icons and natifications in this chapter.

Launching Windows® 7 Action Center
To launch Windows® 7 Action Center:

1. To launch Windows 7 Action Center, click ’P’ 1 message

the Notification icon E, then click Open
Action Center.

'5' Set up backup

Open Action Center

5:45 PM
/1/2009

2. From Windows 7 Action Center, click the task that you want to do.

¥ ) Control Panel » System and Security » Action Center v |42 | Search Control Panel o
Control Panel Home .
Review recent messages and resolve problems
Change Action Centersettings  Action Center has detected one or more issues for you to review.
) Change User Account Control
i Security )
View archived messages -
B s Maintenance (O]

Set up backu
E 3 %) et up backup

Your files are not being backed up.

Turn off messages about Windows Backup

If you don't see your problem listed, try one of these:

Troubleshooting 1) Recovery
& Find and fix problems Restore your computer to an earlier

time,

ASUS CG5270
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Using Windows® Update
Windows Update allows you to check and install the latest updates to enhance the security
and performance of your computer.

Launching Windows® Update
To launch Windows® Update:

1. From the Windows® taskbar, click the Start icon to launch the Start menu.
2. Select All Programs > Windows Update.

3. From the Windows Update screen, click the task that you want to do.

] » Control Panel » System and Security » Windows Update [ 44 | Search Controt Panel

Control Panel Home

‘Windows Update

Check for updates

Change settings =

View update history ‘@ Turn on automatic updating

estos Fickden i dates Updates are not being installed automatically

Tum on autematic updating to help improve the security and
performance of your computer and allow standard users te install

updates on this computer,
%' Turn on automatic updates

Let me choose my settings

Updates: frequently asked
questions

Most recent check for updates:  Never
Updates were installed: Never
Vou receive updates: For Windows only.

Get updates for other Microsoft products. Find out more
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Setting up a user account and password
You may create user accounts and passwords for people who will use your computer.

Setting up a user account
To set up a user account:

1.

I e

From the Windows® taskbar, click ¥ > Getting Started > Add new users.
Select Manage another account.

Select Create a new account.

Key in the name of the new user.

Select either Standard user or Administrator as the user type.

When done, click Create Account.

E 8152, < User Accounts » Manage Accounts b Create New Account | 43 [ Search Control Panet ol

Name the account and choose an account type
This name will appear on the Welcome screen and on the Start menu.

Matthew|

@ Standard user
Standard account users can use most software and change system settings that do not affect other users or
the security of the computer.

*) Administrater
Administrators have complete access to the computer and can make any desired changes. Based on
notification settings, administrators may be asked to provide their password o confirmation before
making changes that affect other users.

We recommend that you protect every account with a strong password.

Why is a standard account recommended?

Ctznceom

ASUS CG5270
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Setting up a user’s password
To set up a user’s password:

1. Select the user that you would like to set a password.
2. Select Create a password.

53, « User Accounts » Manage Accounts b Change an Account ~ | 44 [ search Control Panel o

Make changes to Matthew's account

Change the account name

Matthew

Standard user

Create a password

Changethe picture
Set up Parental Controls
Changethe account type

Delete the account

Manage another account

3. Keyinapassword and confirm it. Key in your password’s hint.

4. When done, click Create password.

43, « Manage Accounts » Change an Account » Create Password ~ |43 || search Control Panet o

Create a password for Matthew’s account

Matthew
Standard user

You are creating a password for Matthew.

If you do this, Matthew will lose all EFS-encrypted files, personal certificates and stored passwords for
Web sites or network resources.

To avoid losing data in the future, ask Metthew to make a password reset floppy disk.

IFthe password contains capital letters, they must be typed the same way every time.
How to create a strong password
Type a password hint
The password hint will be visible to everyone who uses this computer.
What s a passward hint?
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Activating the anti-virus software

Trend Micro Internet Security is pre-installed on your computer. It is a third-party anti-virus
software protecting your computer from virus attacking. It is purchased separately. You have
a 60-day trial period after activating it.

To activate Trend Micro Internet Security:

1. Run the Trend Micro Internet Security application.

2 Carefully read the license terms. Click Agree & Activate.

3. Input your e-mail address and select your location. Click Next.
4

Click Finish to complete the activation.

Getting Windows® Help and Support

Windows® Help and Support provides you with guides and answers in using the applications
in Windows® 7 platform.

To launch Windows® Help and Support, click L= S Help and Support.

[ search Heip 2|

/Cj Find an answer quickly
7 Enter a few words in the search box above.

Not sure where to start?
= How to get started with your computer
= Leam about Windows Basics

= Browse Help topics

More on the Windows website

Check out the Windouws website, which has more information, downloads, and ideas for getting the most out
w of your Windows 7 PC

3, More support options
1M Offline Help v

/ Ensure that you are connected to the Internet to obtain the latest Windows® online help.
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Connecting devices to your computer

Connecting a USB storage device

This desktop PC provides USB 2.0/1.1 ports on both the front and rear panels. The USB
ports allow you to connect USB devices such as storage devices.

To connect a USB storage device:

+  Insert the USB storage device to your computer.

Front panel Rear panel

To remove a USB storage device:

1. Click H from the Windows notification area on your
computer, then click Eject USB2.0 FlashDisk.

@2 Open Devices and Printers

Eject USB2.0 FlashDisk

- Removable Disk (F:)

630 Fivi

1/1/2002 | |

L)

2. When the Safe to Remove Hardware message | @ safe 1o Remove Hardware A x
pops up, remove the USB Storage device from The 'USB Mass Storage Device' device can now be safely
’ remaved from the computer.

your computer.

& DO NOT remove a USB storage device when data transfer is in progress. Doing so may

cause data loss or damage the USB storage device.

ASUS CG5270
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Connecting microphone and speakers

This desktop PC comes with microphone ports and speaker ports on both the front and
rear panels. The audio /O ports located on the rear panel allow you to connect 2-channel,
4-channel, 6-channel, and 8-channel stereo speakers.

Connecting Headphone and Mic

Connecting 2-channel Speakers

AUDIO
INPUTS

Chapter 3: Connecting devices to your computer



Connecting 4-channel Speakers

AUDIO  AUDIO
INPUTS INPUTS

Rear
4 W v i N
)

o )

Connecting 6-channel Speakers

AUDIO AUDIO AUDIO
INPUTS INPUTS INPUTS

ONONO

Rear  Front Center/
Subwoofer

ASUS CG5270
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Connecting 8-channel Speakers
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Connecting multiple external displays

Your desktop PC comes with VGA, HDMI, and DVI ports and allows you to connect multiple
external displays.

R When a graphics card is installed in your computer, connect the monitors on the output
ports of the graphics card.

Setting up multiple displays

When using multiple monitors, you are allowed to set display modes. You can use the
additional monitor as a duplicate of your main display, or as an extension to enlarge your
Windows desktop.

To set up multiple displays:
1. Turn off your computer.

2. Connect the two monitors to your computer and connect the power cords to the
monitors. Refer to Setting up your computer section in Chapter 1 for details on how
to connect a monitor to your computer.

% For some graphic cards, only the monitor that is set to be the primary display has display
- during POST. The dual display function works only under Windows.

ASUS CG5270
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6.

Turn on your computer.

Do any of the following to open the Screen Resolution setting screen:

- Click &2 > Control Panel > Appearance and Personalization > Display >
Change display settings.

+  Right click anywhere on your Windows desktop. When the pop-up menu appears,
click Personalize > Display > Change display settings.

Select the display mode from the Multiple displays: drop-down list.

+  Duplicate these displays: Select this option to use the additional monitor as a
duplicate of your main display.

+  Extend these displays: Select this option is use the additional monitor as an
extension display. This increases your desktop space.

+ Show desktop only on 1/2: Select this option to show desktop only on monitor
1 or monitor 2.

+  Remove this display: Select this options is remove the selected display.

Change the appearance of your displays

Display: 2. ASUS PVITTS
Resolution 1280 x 1024 (recommended) v

Muttiple displays: [Duplicate these displays =

Duplicate these displays

Thisis currently you| p
Show desktop only on 1
he, Show desktop only on 2

Click Apply or OK. Then click Keep Changes on the confirmation message.

[4 Bl
Display Settings ﬂ

Do you want to keep these display settings?

[ Keep changes ]E Revert I

| Reverting to previous display settings in § seconds.
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Connecting an HDTV
Connect a High Definition TV (HDTV) to the HDMI port of your computer.

+ You need an HDMI cable to connect the HDTV and the computer. The HDMI cable is
purchased separately.

+ To get the best display performance, ensure that your HDMI cable is less than 15
meters.

ASUS CG5270
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Using your computer

Proper posture when using your Desktop PC

When using your Desktop PC, maintaining the proper posture is necessary to prevent strain to
your wrists, hands, and other joints or muscles. This section provides you with tips on avoiding
physical discomfort and possible injury while using and fully enjoying your Desktop PC.

Eye level to the top of
the monitor screen
<

Foot rest 90" angles

To maintain the proper posture:

Position your computer chair to make sure that your elbows are at or slightly above the
keyboard to get a comfortable typing position.

Adjust the height of your chair to make sure that your knees are slightly higher than
your hips to relax the backs of your thighs. If necessary, use a footrest to raise the level
of your knees.

. Adjust the back of your chair so that the base of your spine is firmly supported and
angled slightly backward.

. Sit upright with your knees, elbows and hips at an approximately 90° angle when you
are at the PC.

Place the monitor directly in front of you, and turn the top of the monitor screen even
with your eye level so that your eyes look slightly downward.

Keep the mouse close to the keyboard, and if necessary, use a wrist rest for support to
reduce the pressure on your wrists while typing.

Use your Desktop PC in a comfortably-lit area, and keep it away from sources of glare
such as windows and straight sunlight.

. Take regular mini-breaks from using your Desktop PC.
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Using the memory card reader

Digital cameras and other digital imaging devices use memory cards to store digital picture or
media files. The built-in memory card reader on the front panel of your system allows you to
read from and write to different memory card drives.

To use the memory card:

1. Pull down both sides of the cover from the notch area to open it.

2. Insert the memory card into the card slot.
% + Amemory card is keyed so that it fits in only one direction. DO NOT force a card into a
slot to avoid damaging the card.

+ You can place media in one or more of the card slots and use each media independently.
Place only one memory card in a slot at one time.

3. Select a program from the AutoPlay window to access your files.

/ + If AutoPlay is NOT enabled in your computer, click Windows® 7 Start button on the
- taskbar, click Computer, and then double-click the memory card icon to access the data
onit.

+ Each card slot has its own drive icon which is displayed on the Computer screen.

+ The memory card reader LED lights up and blinks when data is being read from or
written to the memory card.

4. When finished, right-click the memory card drive icon on the Computer screen, click
Eject, and then remove the card.

R Never remove cards while or immediately after reading, copying, formatting, or deleting
data on the card or else data loss may occur.

/E To prevent data loss, use “Safely Remove Hardware and Eject Media” in the Windows
g notification area before removing the memory card.
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Using the optical drive

Inserting an optical disc
To insert an optical disc:

1. While your system is on, press PUSH on the drive bay cover to open the tray.
2 Place the disc to the optical drive with the label side facing up.

3. Push the tray to close it.
4

Select a program from the AutoPlay window to access your files.

% If AutoPlay is NOT enabled in your computer, click Windows® 7 Start button on the taskbar,
click Computer, and then double-click the CD/DVD drive icon to access the data on it.

Removing an optical disc
To remove an optical disc:

1. While the system is on, do either of the following to eject the tray:
+ Press PUSH on the drive bay cover.
+ Right-click the CD/DVD drive icon on the Computer screen, and then click Eject.

2. Remove the disc from the disc tray.

ASUS CG5270
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Using the multimedia keyboard
(on selected models only)

7

The keyboard varies with models. The illustrations on this section are for reference only.

ASUS SK-2045 keyboard

IEE0000 0

o

7.

8.

9.

10.

1.

&=

Description
Launches Windows® gadgets.

Activates Windows® Flip 3D.

Reduces picture size in Windows®
Photo Viewer.

Increases picture size in Windows®
Photo Viewer.

Functions with keys F1~F12.

Press <Fn + F1> to launch Microsoft®
Word.

Press <Fn + F2> to launch Microsoft®
Excel.

Press <Fn + F3> to launch Microsoft®
PowerPoint.

Press <Fn + F4> to launch Microsoft®
Internet Explorer.

Press <Fn + F5> to launch Microsoft®
Outlook.

Press <Fn + F6> to launch the
Favorites folder in Windows® Internet
Explorer.

| Description

Press <Fn + F7> to launch Microsoft®
12. H MSN or, if not installed, connects to the

MSN download page.
H ®
1a. Press <Fn + F8> to launch Windows'
"

Search screen.
= |H
16. n
17. u
18. @
19. @
20. @
21. e

0 Launches Windows® Media Center.

Press <Fn + F9> to play or pause
playback in Windows® Media Player.

Press <Fn + F10> to stop playback in
Windows® Media Player.

Press <Fn + F11> to go to the previous
track in Windows® Media Player.

Press <Fn + F12> to go to the next
track in Windows® Media Player.

Decreases the system volume.

Increases the system volume.

Turns the volume’s mute mode on/off.

Launches Windows® Media Player.

7

4-4

The special function keys only work on Windows® Vista / Windows® 7 operating systems.
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ASUS-Razer Arctosa Gaming keyboard

Plays or pauses playback in a media
player.

Stops playback in a media player.

Goes to the previous track in a media
player.

Goes to the next track in a media
player.

Eal

w r b

Decreases the system volume.

o

Increases the system volume.

(=2}
=
) 4

Turns the volume’s mute mode on/off.

~

o

Switches profiles working with F1 ~
ol F10 keys.

+ The special function keys work on Windows® XP / Vista / 7 operating systems.

N

Install the keyboard driver before using. Visit the Razer website at
www.razersupport.com to download the driver.
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www.razersupport.com

BTC 6200C keyboard

Description

Enters into sleep mode. Press any key
to wake up your computer and return to
the previous working status.

Returns to the last page you viewed.

Goes to the next page you viewed
before.

Launches the default homepage in
Windows® Internet Explorer.

Launches the Favorites folder in
Windows® Internet Explorer.

Launches your default email application.

Decreases the system volume.

00000 0

Turns the volume’s mute mode on/off.

o @
0. @
. @
2. @
13. @

Goes to the previous track in a media
player.

Plays or pauses playback in a media
player.

Goes to the next track in a media player.

Stops playback in a media player.

7

+ The special function keys work on Windows® ME / 2000 / XP / Vista / 7 operating

e systems without installing a driver. For Windows® 98SE operating system, visit the BTC
website at www.btc.com.tw to download the driver.

Install Microsoft® Internet Explorer 5.0 or later versions before using the Internet keys.
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Connecting to the Internet

Wired connection
Use an RJ-45 cable to connect your computer to a DSL/cable modem or a local area network
(LAN).

Connecting via a DSL/cable modem
To connect via a DSL/cable modem:

1. Set up your DSL/cable modem.

Refer to the documentation that came with your DSL/cable modem.

2. Connect one end of an RJ-45 cable to the LAN (RJ-45) port on the rear panel of your
computer and the other end to a DSL/cable modem.

Turn on the DSL/cable modem and your computer.

Configure the necessary Internet connection settings.

Contact your Internet Service Provider (ISP) for details or assistance in setting up your
Internet connection.

(X E S
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Connecting via a local area network (LAN)
To connect via a LAN:

1. Connect one end of an RJ-45 cable to the LAN (RJ-45) port on the rear panel of your
computer and the other end to your LAN.

Turn on your computer.

Configure the necessary Internet connection settings.

Contact your network administrator for details or assistance in setting up your Internet
connection.

(&Sﬂ!\)
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Wireless connection (on selected models only)

Connect your computer to the Internet through a wireless connection.

AN

To establish a wireless connection, you need to connect to a wireless access point (AP).

N

To increase the range and sensitivity of the wireless radio signal, connect the external
antennas to the antenna connectors on the ASUS WLAN Card.

Place the antennas on the top of your computer for the best wireless performance.

The external antennas are optional items.

ASUS CG5270
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To connect to a wireless network:

1. Click the network icon ' in the notification area to display the available wireless

networks.

Not connected s
:Elﬂ Connections are available

Wireless Network Connection ~
WL-530gV2 .
Asus-WIFE |
As Office Al
$5D-10 A
DAOQ ol U
$5D-130 )

Open Netwerk and Sharing Center

2. Select the wireless network that you want to connect to, then click Connect.

| Not connected ¥ |* I

dﬂ:‘] Connections are available

Wireless Network Connection -

WL-530gV2

Connect automatically Connect

Asus-WIFI o

As Office El

DAOQ |

SSD-10 o

Alva ol

55D-130 il
Open Network and Sharing Center

3. You may need to key in the network security key for a secured wireless network, then
click OK.

2 Connect to a N

Type the network security key

Vi
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4. Wait while your computer is connecting to the wireless network.

Connecting to WL-530gV2 .

= — =/

5. The wireless connection is established successfully. The connection status is displayed
and the network icon displays the connected status.

W Currently connected to: 4 LI
WL-5309V2
Internet access
Wireless Network Connection -
WL-530gV2 Connected |
Asus-WIFI FNE
As Office |
default M
550-130 Al
DAOQ !J”
SSD-10 o
Ala -
Open Network and Sharing Center
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Using the Utilities

ASUS Al Manager

ASUS Al Manager is a utility which gives you quick and easy access to frequently-used
applications.

Installing Al Manager
To install Al Manager:

1. Place the support DVD in the optical drive. If Autorun is enabled, the Drivers installation
wizard appears.

% If Autorun is disabled, double-click the setup.exe file from the ASUS Al Manager folder in
the support DVD.

2. Click the Utilities tab, then click ASUS Al Manager.
3. Follow the onscreen instructions to complete the installation.

Launching Al Manager
To launch the Al Manager from the Windows® desktop, click Start > All Programs > ASUS >
Al Manager > Al Manager 1.xx.xx. The Al Manager quick bar appears on the desktop.

Sl | © | @ #8E

After launching the application, the Al Manager icon appears in the Windows® taskbar.
Right-click this icon to switch between the quick bar and the D
main window, and to launch the Al Manager either from the
quick bar or taskbar.

Switch to Quick Bar
Switch to Main Window

Start at Quick Bar
v Start at ToolBar

Exit

ASUS CG570 6-1



Al Manager quick bar

The Al Manager quick bar saves the desktop space and allows you to launch the ASUS
utilities or display system information easily. Click any of the Main, My Favorites, Support or
Information tab to display the menu’s contents.

ol ) ?\ﬁ

Main Support

Switch to main Window
Add to ToolBar

My Favorites Information

Click the Maximize/restore button Il to switch between full window and quick bar. Click the
Minimize button B to keep the Al Manager on the taskbar. Click the Close button (= quit
the Al Manager.

Main

The Main menu contains five utilities: Al Disk, Al Security, Al Boosting, and Al Probe. Click
the arrow on the Main menu icon to browse through the utilities in the main menu.

| | e | - y L]
QR0 &0 LB, &
ANEESSL SR Ak "l

m Al Marnaoer —
Click to display

Click to extend or restore items on the right

Click to display-
items on the left

Al Disk

Al Disk allows you to easily clear temporary IE files, IE cookies, IE URLs, IE history,
or the Recycle Bin. Click the Al Disk icon on the quick bar to display the full Al Disk
window and select the items you want to clear. Click Apply when done.

2~ Beoa

LB AT DS

Select the items that you want to clear.
@ Sunnont

[ Clear Temporary [E Files [T Clear IE URL(s) History
Information
[~ ClearIE Cookiss [T ClearE History
[ ClearRecycle Bin [ Clear Recently Opened Files
Vi
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Al Security
Al Security enables you to set a password to secure your devices, such as USB flash
disks and CD/DVD disks, from unauthorized access.

To lock a device:

1. When using Al Security for the first time, you are asked to set a password. Key in
a password with at most 20 alphanumeric characters.

2. Confirm the password.
Key in the password hint (recommended).
When done, click Ok.

_ B
(WA EREEER -

B&e &

ALSecURitY,

Input a password first, or you can not use the function

* Input new password(ax length is 20 chars)

.-

* Re-Input new password
* " representyou mustfil it

Input new password hint

5. Select the device you want to lock, then click Apply.
6. Key in the password you have set previously, then click Ok.

DR &

ALSecURItY,

Lock or unlock the device(s). When selected, the device is not
accessible.

[V USB Flash Disk(s)

[T cD\DVD Disk(s)

[ cnangepasswom | [ ey

To unlock the device:

1. Deselect the locked device, then click Apply.

2. Key in the password you have set previously, then click Ok.
To change the password:

+  Click Change Password, then follow the onscreen instructions to change
password.
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Al Booting

Al Booting allows you to specify the boot device priority sequence.

VTUZH—\
@ AT'NVanager - =

ﬁ Main

L &0

My
Favorites
sequence.

ANBoating|

2

‘Selectthe device, then dlick the Ieft/ right button to modify the boot

e— &

Hard Disk

&

D\DVD

< >

3
L1
Fiash Disk

To specify the boot sequence:

1. Select a device, then click the left/right button to specify the boot sequence.

2. When done, press Apply.

Al Probe

Al Probe automatically detects and displays the motherboard and CPU temperatures,
CPU fan speed, and the voltage output. You can adjust the values as you need.

Click the Temperature, Voltage, or Fan Speed tab, then select an item to enable and

change the value by dragging the bar.

T

AlRRobe!

My
Favoiites

| Temperatwe | & votage

[ ranspees

@ support
[ o

Enabed | Sensor |

| Curent |

Threshold

d ﬁ i = ue

]
£

— 70 °C
Oo— = o
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My Favorites

My Favorites allows you to add applications that you frequently use, saving you from
searching for the applications throughout your computer.

Paint Wi
e

Media Player

To add an application:
1. Click Add, then locate the application you want to add to My Favorites.
2. Click Open on the file location window. The application is added to My Favorites list.

Right click on the application icon to launch, delete, or rename the selected application. You
can also double click to launch the selected application.

Support

Click any links on the Support window to go to the ASUS website, technical support website,
download support website, or contact information.

ASUSTeK Computer - International Web Site

ASUSTeK Computer - Online Technical Support Web Site

USTeK Computer - Online D Web Site

ASUSTeK Computer - Contact Information

ASUS CG5270
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Information

Click the tab on the Information window to see the detailed information about your system,
motherboard, CPU, BIOS, installed device(s), and memory.

Systemilnfonmation

My
Favorites

@
Support Manufacturer:  ASUSTeK Computer INC.
Motherboard:  CG5270

CPU:  Intel(R) Core(TW)2 Quad CPU Q8300 @ 2506Hz
Information sl Amefican Megairends inc
© Ver 0302

RAM: 8191MB

ASUS EPU-4 Engine

ASUS EPU-4 Engine is an energy-efficient tool that provides you with a total system
power-saving solution. It detects the current computer loading and intelligently adjusts
the power in real-time. It automatically adjusts the power usage for the CPU, VGA card,
hard drives, and CPU fan. It provides you with these modes to choose from: Auto, High
Performance, and Maximum Power Saving Mode.

/ Refer to the section ASUS EPU-4 main screen for more details about these modes.

Installing ASUS EPU-4
To install ASUS EPU-4 Engine:

1. Place the support DVD into the optical drive. The Drivers menu appears if Autorun is
enabled on your computer.

If Autorun is disabled, double-click the setup.exe file from the ASUS EPU-4 Engine folder
in the support DVD.

2. Click ASUS EPU-4 Engine.

3. Follow the onscreen instructions to complete the installation.

Launching ASUS EPU-4
To launch ASUS EPU-4:

1. From the Winqowstaskbar, click the i 11:18 AM
ASUS EPU-4 icon. * " 1001072000
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2. When you launch ASUS EPU-4 for the
first time, @ message appears asking
you to calibrate the EPU functions.

Click Calibrate and wait for a few
seconds for the calibration process
to complete. The ASUS EPU-4 main
menu appears.

% Calibration allows the system to detect the CPU properties for optimal power management.

ASUS EPU-4 main screen

EPU-4 Engine
t@

5 Total reduced =mission

CPU status
Displays the current CPU power and the total CPU power saved.
VGA card status

Displays the status of the graphics card. If your graphics card is not compatible
with the motherboard, a “No VGA card detected” message appears.

Refer to the ASUS VGA QVL List at http://event.asus.com/mb/EPU-4_Engine/ for
compatible VGA cards.

N © ©
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HDD status
Lights up when the power saving mode is activated.

Fan status
Display the current fan status.

CO02 Emission button
Displays the current or total reduced CO2 emission.

Mode properties
Displays the properties of each mode.

Exit button
Closes the ASUS EPU-4 utility,

Calibrate button
Allows the system to detect the CPU properties for optimal power management.

Setting button
Click this button to configure the mode settings.

© 00 0 6 060

/ Refer to the section Configuring the mode settings for more details.

@ Modes

Auto Mode

i When you select this mode, the system changes modes
automatically according to the current system status.
E High Performance Mode

When you select this mode, the system overclocks the components
for maximum performance.

Maximum Power Saving Mode
—1 | When you select this mode, the system automatically adjusts the
power usage for critical components in real-time to save power.
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Configuring the mode settings
To configure the mode settings:
1. From the ASUS EPU-4 main menu, click Setting to launch the Setting screen.

2. Click the -! tab to configure the settings of High Performance mode. Click

the
3. Configure any of these mode settings:

tab to configure the settings of Maximum Power Saving mode.

vCore Voltage Downgrade: Lowers CPU vCore voltage.

Heavy: Downgrades voltage to the highest level for CPU power saving.
+ Medium: Downgrades voltage to the medium level.
+  Small: Downgrades voltage to the minimum level.

Turn Off hard disks: Turns off hard disk drives when they are not accessed after a
certain time.

CPU Loadline: Sets up the CPU loadline to manage CPU power saving.
+  Light: Saves CPU power to the minimum level.

+ Medium: Saves CPU power to the medium level.

+ Heavy: Saves CPU power to the highest level.

Turn Off Screen: After the specified idle time, the screen turns off while all background
tasks are still running.

4. Click OK to apply the settings made.
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ASUS Update

The ASUS Update is a utility that allows you to manage, save, and update the motherboard
BIOS in Windows® environment.

+ ASUS Update requires an Internet connection either through a network or an Internet
Service Provider (ISP).

+ This utility is available in the support DVD that comes with the motherboard package.

Installing ASUS Update
To install ASUS Update:

1. Place the support DVD in the optical drive. The Drivers menu appears.

% If Autorun is disabled, double-click the setup.exe file from the ASUS Update folder in the
- support DVD.

2. Click the Utilities tab, then click Install ASUS Update.

3. Follow the onscreen instructions to complete the installation.

% Quit all Windows® applications before you update the BIOS using this utility.

Updating the BIOS
To update the BIOS:

1. From the Windows® desktop, click Start > Programs > ASUS > ASUS Update >
ASUS Update to launch the ASUS Update utility.

2. From the dropdown list, select any of the updating process:

Updating from the Internet
a. Select Update BIOS from the Internet, then click Next.

b.  Select the ASUS FTP site nearest you to avoid network traffic, or click Auto
Select then click Next.

c. From the FTP site, select the BIOS version that you wish to download then click
Next.

% The ASUS Update utility is capable of updating itself through the Internet. Always update
the utility to avail all its features.

Updating from a BIOS file
a. Select Update BIOS from a file, then click Next.

b. Locate the BIOS file from the Open window, then click Open.

3. Follow the onscreen instructions to complete the updating process.
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ASUS MyLogo2™

The ASUS MyLogo2™ utility lets you customize the boot logo. The boot logo is the image
that appears on screen during the Power-On Self-Tests (POST). ASUS MyLogo2™ is
automatically installed when you install the ASUS Update utility from the Support DVD.

R + Obtain the latest BIOS file from the ASUS website at www.asus.com.

+ You can create your own boot logo image in GIF file format.

To launch ASUS MyLogo2™:

1.

Launch the ASUS Update utility. Refer to the section “ASUS Update” in this user
manual for details.

Select Options from the drop down menu, then click Next.

Check the option Launch MyLogo to replace system boot logo before flashing
BIOS, then click Next.

Select Update BIOS from file from the drop down menu, then click Next.

When prompted, locate the new BIOS file, then click Next. ASUS MyLogo window
appears.

From the left window pane, locate the
image that you want to use as your boot
logo. Click Next.

From the Ratio dropdown list, select your
desired size for the boot logo. Click Next.

The system starts updating the BIOS and
loading the new boot logo.

After the updating process, the system
restarts and displays the new boot logo o
during POST. : —

ASUS CG5270

6-11



6-12

Nero 9

Nero 9 allows you to create, copy, burn, edit, share, and update different kinds of data.

Rip and Bum

Create and Edit

H
Entertainment

J L

Data Burning Welznin
— Nero StartSmart!

Manage your projects
step-by-step with the
application launcher
that does it all.

Special direct functions
en easier!

Complete your
tasks quickly
and easily

(

Add/Remove.

NEWS Insert transitions into a slide show
|

Installing Nero 9
To install Nero 9:

1. Insert the Nero 9 DVD into your optical drive.

2. If Autorun is enabled, the main menu appears automatically.

7

9 DVD.

If Autorun is disabled, double-click the SeupX.exe file from the main directory of your Nero

3. From the main menu, click Nero 9 Essentials.
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4. Select the language you want to use for Installation Wizard. Click Next.

Welcome to the Installation of Nero 9 Essentials

nero 9

This wizard wil guide you through the instalation process
for Nero 9 Essentials. Just dick 'Next’ to go through the
instalation steps.

Warning: This software is protected by international
copyright laws.

TR Usc this language for the instalation wizard

5. Click Next to continue.

6.

ASUS CG5270

Personalize Your Nero 9 Essentials

Please enter your serial number for Nero 9 Essentials

T SPM02-K08X-AC3L-7 M3U-232H-C925-9AH 3-APBZ-5441 |9

License Conditions (EULA)

Please read the License Conditions carefully

End-User License Agreement

P

selection of components, that varies with different sute types, as wel s standalone:
from the folowing Ist: NeroE: In

IrCD Reader, Nero Tookt, . Ne

ISoundTrax, Nero BackItup, Nero Live, Nero Live Gadget, Nero Vision,

ishowTime, Nero Photosnap, Nero Photosnap Viewer, Nero MediaHome, DTS Plug+n, Bluray
Video Plug-n, Gracenote Plug-in, SecurDisc Viewer, Nero RescueAgent, Nero DiscCopy.
(Gadget, Nero Baddtup &Bum (Software)

Licensor: era AG (Mero

ITHIS 1S A LEGAL AGREEMENT BETWEEN YOU, THE 'END USER”, AND NERO AG, IM
ISTOECKMAEDLE 13-15, 76307 KARLSBAD, GERMANY.

|CONCLUSION OF THE CONTRACT

Taccept the License Conditions




7.

8.

9.

Select Typical then click Next.

Nero 9 Essentials - Installation

Select Installation Type

Please select an installation type

Typical
The standard instalation wil be executed.

Custom
Select the Nero appications to be installd, theirlocation and the
languages. Only recommended for experienced users.

Tick Yes, | want to help by sending anonymous application data to Nero then click

Next.

Nero 9 Essentials - Installation

Help us to Enhance Nero Software

problems, f any, may occur.

W Yes, Iwant to help by sending anonymous applcation data to Nero

‘You can also join at a ater time by opening the Nero ConroiCenter and clcking on Product Settings.

s not colect any personal information that can be used to contact the individual user. For more detals about

> guards your privacy, please read our privacy statement.

When done, click Exit.

In order to offer better service, Nero is colecting anonymous data to determine which features are used and what

If you would ke to participate in this anonymous data collection now, smply cick on the following check box.

Nero 9 Essentials - Installation 0

Installation Successful

nero g

# The instalation wizard has successfuly installed Nero 9
sent
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urning files

To burn files:

1.

2.

From the main menu, click Data Burning > Add.

Start Page RipandBum | Create and Edit Em’:“;m“m

(3] .
Date Buming | Burn Data Disc .
T
L ) ) () (@] S
-

e e [t ettt v T
LU LIS UL UL WL ([ )

What's New?

. My Nero Community

Select the files that you want to burn. When done, click Add.

Next

% Add files and folders

==

Online

P = 0

B Desktop » - [ 44| search Desktop 2|
Organize ~ New folder B~ @
4 7% Favorites (5 Libraries
B Desktop | U‘SJ System Folder
18 Downloads ~ |
‘& Recent Places €G5270
& System Folder
41 Libraries
1 g Computer
© [H Documents  |2| || System Folder
> g Music No preview available,
© [ Pictures ativork
> B videos System Folder
‘Adobe Reader 8
4 1% Computer Shortcut
& WINT (C) 197 KB
© s DATA (D) | Microsoft Office60 D: _

File name: ~ [ Files )y -
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3. After selecting files that you want to burn, click Burn to burn the files to a disc.

| ‘
&) )
e Elming Burn Data Disc
o | o
[\ ~) (5] (8] (@ada ) [Speee |
Name Size (0 MB)
Paint.ink 1KB
I R P P P PR P W = | 7 50r |
NEWS ‘m My Nero Community Q Nero 9 s 0 easy to usel ‘ Next

For more details about using Nero 9, refer to the Nero website at www.nero.com

7

Recovering your system

The bundled Recovery DVD assists you in reinstalling the operating system and restoring it
to its original working state.

All data will be lost during the recovery process. Before recovering the system, ensure
o that you back up all your data and take note of any customized settings such as network
settings.

To recover your system:

1. Turn on your ASUS Desktop PC. When the ASUS logo appears, press <F8> to enter
the Please select boot device menu.

2. Insert the recovery DVD into the optical drive and select the optical drive (CDROM:
XXX) as the boot device. Press Enter and then press any key to continue.

3. Wait until the Hard-Disk Information screen appears. Select where to install a new
system. Options are:

Recover system to a partition

This option deletes only the partition you selected, allows you to keep other partitions,
and creates a new system partition as drive “C.” Select a partition and click NEXT.

Recover system to entire HD

This option deletes all partitions from your hard disk drive and creates a new system
partition as drive “C.” Select and click Yes.
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Tick | accept then click Next.
Follow the onscreen instructions to complete the recovery process.

Click OK on the confirmation message to eject the disc from the optical drive and the
system restarts.

After the system restarts, Windows® 7 begins its system configurations. Follow the
onscreen instructions to complete the process, and the system automatically restarts.

R This recovery DVD is for ASUS Desktop PC only. DO NOT use it on other computers. Visit

the ASUS website www.asus.com for any updates.

Quickly recover your system

1.

Turn on your ASUS Desktop PC. When the ASUS logo appears, press F9 to enter the
System Recovery.

2. Windows is loading files is shown. Wait until the Recovery CD/DVD window
appears.

3. Follow the onscreen instructions to complete the recovery process. After the system
reboots, display resolution and system settings are restored to their default values.

ASUS CG5270
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Troubleshooting

This chapter presents some problems you might encounter and the possible solutions.

? My computer cannot be powered on and the power LED on the front
panel does not light up

. Check if your computer is properly connected.
. Check if the wall outlet is functioning.

Check if the Power Supply Unit is switched on. Refer to the section Turning
your computer ON/OFF in Chapter 1.

? My computer hangs.

. Do the following to close the programs that are not responding:
1. Simultaneously press <Alt> + <Ctrl> + <Delete> keys on the keyboard,
then click Start Task Manger.
2. Click Applications tab.
3. Select the program that is not responding, then click End Task.

. If the keyboard is not responding. Press and hold the Power button on the top
of your chassis until the computer shuts down. Then press the Power button to
turn it on.

? I cannot connect to a wireless network using the ASUS WLAN Card
(on selected models only)?

. Ensure that you enter the correct network security key for the wireless network
you want to connect to.

. Connect the external antennas (optional) to the antenna connectors on the
ASUS WLAN Card and place the antennas on the top of your computer
chassis for the best wireless performance.

?  The arrow keys on the number key pad are not working.

Check if the Number Lock LED is off. When the Number Lock LED is on,

the keys on the number key pad are used to input numbers only. Press the
Number Lock key to turn the LED off if you want to use the arrow keys on the
number key pad.
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No display on the monitor.

Check if the monitor is powered on.

Ensure that your monitor is properly connected to the video output port on your
computer.

If your computer comes with a discrete graphics card, ensure that you connect
your monitor to a video output port on the discrete graphics card.

Check if any of the pins on the monitor video connector is bent. If you discover
bent pins, replace the monitor video connector cable.

Check if your monitor is plugged to a power source properly.

Refer to the documentation that came with your monitor for more
troubleshooting information.

When using multiple monitors, only one monitor has display.

Ensure that the both monitors are powered on.

During POST, only the monitor connected to the VGA port has display. The
dual display function works only under Windows.

When a graphics card is installed on your computer, ensure that you connect
the monitors to the output port on the graphics card.

Check if the multiple displays settings are correct. Refer to section
Connecting multiple external displays in Chapter 3 for details.

My computer cannot detect my USB storage device.

The first time you connect your USB storage device to your computer,
Windows automatically installs a driver for it. Wait for a while and go to My
Computer to check if the USB storage device is detected.

Connect your USB storage device to another computer to test if the USB
storage device is broken or malfunctions.

| want to restore or undo changes to my computer’s system settings
without affecting my personal files or data.

The Windows® System Restore feature allows you to restore or undo changes
to your computer’s system settings without affecting your personal data such
as documents or photos. For more details, refer to the section Restoring your
system in Chapter 2.
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?  The picture on the HDTV is stretched.

It is caused by the different resolutions of your monitor and your HDTV. Adjust
the screen resolution to fit your HDTV. To change the screen resolution:

1. Do any of the following to open the Screen Resolution setting screen:

Click 8% > Control Panel > Appearance and Personalization >
Display > Change display settings.

+ Right click anywhere on your Windows desktop. When the pop-up
menu appears, click Personalize > Display > Change display
settings.

2. Adjust the resolution. Refer to the documentation came with your HDTV
for the resolution.

3. Click Apply or OK. Then click Keep Changes on the confirmation
message.

? My speakers produce no sound.

Ensure that you connect your speakers to the Line out port (lime) on the front
panel or the rear panel.

Check if your speak is connected to a electrical source and turned on.

Adjust your speakers’ volume.

Ensure that your computer’s system sounds are not Muted.
If it is muted, the volume icon is displayed as m . To enable the system
sounds, click from the Windows notification area, then click | ¢ .
If it is not muted, click m and drag the slider to adjust the volume.

Connect your speakers to another computer to test if the speakers arer
working properly.

?  The DVD drive cannot read a disc.

ASUS CG5270

Check if the disc is placed with the label side facing up.

Check if the disc is centered in the tray, especially for the discs with
non-standard size or shape.

Check if the disc is scratched or damaged.
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?

The DVD drive eject button is not respond.

1. Click > Computer.

. . ‘ DVD RW Drive i )
2. Right-click @ , then click Eject from the menu.
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